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Capital Equipment  
Definition of Capital Equipment  
Capital equipment is defined as an article of nonexpendable, tangible personal property 
with a useful life of more that one year and an acquisition cost (including freight and 
installation charges) of at least $1,500. RIT also capitalizes software with a cost of 
$100,000 or more. All capital equipment is recorded as an asset on the general ledger at 
the time it’s purchased using object code 16200. 
 
The primary responsibility for safeguarding RIT’s assets lies with Property Control, a 
unit within the Accounting/Financial Reporting group of the Controller’s Office. 
However, departments across the Institute can assist in this important area by following a 
few simple guidelines developed by Property Control. Refer to the Controller’s Office 
web page for guideline to follow when purchasing capital equipment: 
http://finweb.rit.edu/controller/forms/Capital_Equipment_Guidelines.pdf.  
 
Upcoming Physical Inventory 
In addition to the guidelines for purchasing capital equipment, the Controller’s Office is 
responsible for coordination of the annual capital equipment physical inventory. 
Information about the inventory was mailed to RIT managers and department contacts 
during the week of March 15th. To enhance the accuracy and completeness of RIT’s 
financial statements, all departments have been asked to complete their inventories and to 
return information to the Property Control Office by May 21st.  If you have any questions 
about the physical inventory process, call Janie McGrath-Briggs, Fixed Asset Analyst, at 
ext. 5-4933 (e-mail: jfmcto@rit.edu). 
 
Employee Self Service Corner 
Payroll Direct Deposit – Adding a New Account 
What is a “pre-note”? 
In order to set up direct deposit to a new bank account, you must first open the account 
with your financial institution. When the next payroll is run, the Payroll Office will 
submit a zero dollar transaction to your financial institution as a test. This “prenote” is a 
prenotification to the financial institution of the transaction to verify new bank account 
information before actual funds are transmitted. When viewing your payslip online, you 
will see the new account on your payslip with a zero dollar figure to indicate that the 
prenote process has occurred. Once this prenote process has been completed, the actual 
deposit will be made to your bank account during the next payroll period. 
 
Frequently Asked Questions about Employee Self Service 
For a complete list of Self Service frequently asked questions and responses, please visit 
the Customer Support web page at: 
http://finweb.rit.edu/customersupport/emp_self_serve_faq.html

http://finweb.rit.edu/controller/forms/Capital_Equipment_Guidelines.pdf
mailto:jfmcto@rit.edu
http://finweb.rit.edu/customersupport/emp_self_serve_faq.html
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Encumbrances 
What are Encumbrances? 
RIT’s fiscal year end is just around the corner. One way to prepare for year-end is to 
review your department’s encumbrances. Encumbrances are reservations of funds for 
future expenditures. Encumbrances are created automatically by the system when a 
requisition (later on a Purchase Order) is created. The account number used on the 
requisition will be the same account number that will reflect the encumbrance amount on 
your department or project statement. The encumbrance will give you a better picture of 
your budget because, by reserving the amount of funds specified on the requisition, it will 
remind you that those funds are no longer available for your department’s use (e.g., 
because they have been put aside for an expenditure that has been committed to). The 
following example will provide a step- by- step illustration of the encumbrance process. 
 

• You are asked to process a requisition to purchase a computer for $1,700 for your 
department. Once you enter the requisition into Oracle, the system takes $1,700 
from your “Available Balance” on the 24-digit account that you specified and 
automatically creates an encumbrance for the same amount. When Accounting 
pays the invoice, the encumbrance will be reversed and an expense of $1,700 will 
be reflected in the “Actual” and “YTD Actual” columns on your capital 
equipment statement. 

 
Sometimes, discrepancies in the amount billed, or other factors may complicate this 
process and possibly prevent the encumbrance from clearing completely.  
 
What’s the best way to reconcile open encumbrances? 
If, after printing your department or project statements, there are amounts in the 
“Encumbrance” column, print an “Encumbrance Detail Report” (EDC – see instructions 
below). Compare the encumbrance amounts of both reports. If they match and you 
recognize the Purchase Order (PO) number in the EDC, then it’s likely the information is 
correct. If they don’t match, one possible reason is that there is an amount on the PO that 
was never used and it’s still encumbered. If that is the case, call Purchasing (ext. 5-2107) 
and ask them to “finally close the PO”. If you have questions about reconciling 
encumbrances, call David Castro at ext. 5-2237. 
 
Tips for Running the Encumbrance Detail Report: 
Run the Encumbrance Detail Report after you have run your department statement or 
other Oracle reports and you notice that there are amounts in the Encumbrance column. 
Here is an example of how to complete the Parameter screen when requesting an 
Encumbrance Detail Report: 
 
To get to the Parameters screen, log into Oracle through your Report & Inquiry 
responsibility. Double click on Reports. When the next window appears click on the Ok 
button, selecting Single Request. Within the Submit Request screen type enc in the 
name field and press the Tab key. Select Encumbrance Detail Report from the list and 
click on the OK button.  



Final  RIT – Internal Use Only 

Controller’s Office 3 of 6 Rev: March 17, 2004 

 

 
 
As shown in the image above, the account number field and the Encumbrance Date 
(only the “to” date) are the only fields required to request this report. After you complete 
these fields, click on the OK button and submit /print the report. 
 
What’s New in Accounting? 
Changes to Account Numbers on Capital Equipment Statements 
Effective March 1, 2004 the 24 digit account combinations used for non-capitalized 
expenses on your capital equipment project accounts (i.e., 84000 - equipment less than 
$1,500) changed. All expense account combinations will now include the same 
Functional Expense Category (FEC) as the one used for your department’s operating 
account.  This change is intended to streamline the preparation of external financial 
statements and in addition, to eliminate the confusion that has arisen from using FEC 
“00” with expense object codes on capital equipment accounts.  
  

•    Here’s an example for a 24 digit account combination for a $1,400 printer that 
you are charging to your department’s operating account:  

  
01 . 63100 . 84000 . 10 . 00000 . 00000 
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•    Here’s an example of the account number to use when purchasing the printer from 
your department’s capital equipment project account: 

  
01 . 63100 . 84000 . 10 . 84200 . 00000 (note that the FEC = 10) 

  
When an expenditure is for capital equipment (equipment greater than >$1,500), please 
continue to use asset object code 16200 with a FEC of “00” in the account combination.   
  

•    Here’s an example of the account number to use when purchasing capital 
equipment: 

  
01 . 63100 . 16200 . 00 . 84200 . 00000 

  
Accounting disabled all expense account combinations for Project 84200 with a “00” 
FEC effective March 1, 2004. Accounting also set up new account combinations, using 
your department’s FEC. Please begin to use the new accounts for all purchases (including 
purchase requisitions and procurement card purchases) beginning on March 1st.  
  
Contact David Castro, GL/AP Customer Support Specialist at ext. 5-2237, if you have 
any questions about this change. 
 
Accounting for Gifts-in-Kind 
RIT often receives gifts of equipment, software, printed materials, supplies, etc. from 
donors. These non-cash donations of materials or long-lived assets are referred to as gifts-
in-kind. For financial reporting purposes, gifts-in-kind are recorded on the general ledger 
by Development as “gift income” and as a “gift-in-kind expense”.  
 
In order for departments to have access to gift-in-kind information, effective April 1st 
Development will begin to record gift-in-kind income and expenses on the general ledger 
account of the department that received the gift. In the past this information was recorded 
on a General Institute account. This change will be effective for all gifts-in-kind received 
during fiscal year 2004.  
 
Watch for more information about this change in the Accounting March Closing memo. 
 
Oracle Referesher 
How to Set Up your Oracle Default Printer 
The list of networked printers for printing Oracle reports is quite long and the name of 
your printer may not be easy to recognize in the List of Values. You may set up your 
networked printer in Oracle so that your printer's name defaults and you don't have to 
select it from the list of values.  

Below are step-by-step instructions: 

1. In the Navigator screen double click on the "Other" menu option, and then on   
"Profile".  
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2. Under the "View" menu click on “Query By Exanple”, and then click on "Enter". 
3. In the "Profile Name" field type "Pri%". 
4. Under the "View" menu click on “Query By Example”, and then click on "Run". 
5. Place the cursor in the "User Value" field of the “printer” profile row.  
6. Click on the "List of Values" icon on the tool bar, and select your Printer's name 

from the list.  
7. Click on the "Save" icon on the tool bar to save the settings. 

Oracle Reprint Function 
A common question from Oracle users is "How can I go back and print a report that has 
completed, but was not submitted to print?" The answer to this question is the "Reprint 
Function". Below are step-by-step instructions for reprinting Oracle reports: 

1. Once the report you submitted has completed, make a note of the request id 
number. 

2. From the “Navigator” screen click on the “View” menu, and then on “Requests” 
3. In the “Find Requests” screen click on “Find” to select the “All My Requests” 

option. 
4. Find the request id for the report you want to reprint, and place the cursor in that 

row. 
5. Under the "Tools" menu select "Reprint". 
6. The "Reprint Options" screen will open.  Select the number of copies and the 

printer, and click "OK". 
7. Click on the “Refresh Data” button to view the progress of the reprint request. 

General Ledger Object Codes 
Chances are that you have come across an Oracle account segment that you are unable to 
decipher. Don’t be frustrated! Each Oracle general ledger account numbers consist of five 
segments (pieces), and for some of the segments (i.e., Department, Object, and Project), 
there are hundreds of numbers that have been created in the general ledger. The good 
news is that there is an easy way to find out more about these account segments. Visit the 
Controller’s Office web page for information about the Chart of Accounts: 
http://finweb.rit.edu/controller/accountno.html.  
 
Click on the segment that you need information about (see the next page to view the 
sample screen). For the purpose of this example, we have selected “Object” and entered 
object code 75000. You can also enter a description. Click on the Search button. If that 
particular object code or description exists in the Oracle chart of accounts, a list matching 
the search criteria will display on the page. You can copy the information on the list and 
paste it into Word for future reference. If you need help using this tool call David Castro 
at extension 52237. 
 
 

http://finweb.rit.edu/controller/accountno.html
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Segment Value Listings 
The new accounting number, stored in an accounting flexfield in the Oracle database, is 
comprised of twenty-four digits and divided into six segments as listed below. To see a report 
listing the values for each segment, click on the segment name.  

Segment Digits Entries 
Entity 2 4 

Department 5 950 

Object 5 1376 

Expense 
Category 2 16 

Project 5 2747 

Academic 
Discipline 
Code

5 2 

 
 

Object Account Number Structures 

You can either enter the Object Number in the To From fields or you can search for an Object by 
typing the Object Name in the Object Name field. Wildcards are accepted in the Object Name 
field. The wildcard is the standard Oracle wildcard '%'  

7500From Object:  0
 

To Object:  75000
 

Object Name:  

Clear
 

Search

 

Search Results 

Search returned 1 results. 

Object Description 
75000 PROFESSIONAL FEES 

 

http://finweb.rit.edu/controller/g_l/EntityForm
http://finweb.rit.edu/controller/g_l/DepartmentForm
http://finweb.rit.edu/controller/g_l/ObjectForm
http://finweb.rit.edu/controller/g_l/ExpenseForm
http://finweb.rit.edu/controller/g_l/ExpenseForm
http://finweb.rit.edu/controller/g_l/ProjectForm
http://finweb.rit.edu/controller/g_l/ADCForm
http://finweb.rit.edu/controller/g_l/ADCForm
http://finweb.rit.edu/controller/g_l/ADCForm
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